
Mapping Wholemount data with MAPaint

The information associated with this example is as follows:

The embryo is from Kirsten Steiner and Patrick Tam, Children's Medical Research
Institute, Sydney.  An antisense digoxigenin labelled mRNA probe for Sox10 was used.
The probe was transcribed from a clone that contains an ~800bp PstI fragment of the
Sox10 cDNA which covers 3'UTR sequence only.  The probe was a gift from Peter
Koopman.  The specimen is a 9.5dpc embryo.  The visualisation method used in this
experiment was Alkaline Phosphatase with NBT and BCIP and the expression domain
has been described as the neural crest, with prominent streams of migrating cells
adjacent to rhombomeres 2 and 4.

Original image:

Sox10.jpg

This Sox10.jpg file was saved into your home directory for the purposes of this course.
To view this image, use the normal image viewing program available on your operating
system (eg. preview, image magick, photoshop etc).

What Theiler stage is this embryo?___________________________________________

In order to spatially map this gene expression data for inclusion in the EMAGE database,
the image must first be read into MAPaint. Expression patterns in the original image are
then 'warped' or 'morphed' onto a wholemount image of one of the standard model
embryos.  Different levels of gene expression are defined using varying threshold levels of
colour intensity from the original image.

 In an xterm window, change to your home directory

% cd

 Then make a directory (folder) in your home area for the source image
and give it the name "wholemount".



% mkdir wholemount

 Move the original image file (in jpg or tiff format) into this new directory.
This Sox10.jpg file was saved into your home directory for the purposes
of this course.

% mv Sox10.jpg wholemount

 Change to the new directory that you have made.

% cd wholemount

 To check the file is in this directory, you can list its contents by typing

% ls

 Open the version of MAPaint required for spatially mapping data for
EMAGE by typing on the command line…

% MAPaint_EMAGE &

Since you started MAPaint in this directory ("wholemount"), whenever
you now save files during this session of MAPaint, they will all be saved
into the "wholemount" directory.

A window called "MAPaint_EMAGE" will open:

Select from the "File" menu, "Open EMAP Model".  The 2D and 3D
'EMAP Model' image files of the standard embryos are on the CD.  In
your home laboratory you can copy these to your hard drive.  If reading
from the CD, firstly make sure the CD-ROM is inserted, and then
navigate to it from within the MAPaint program (on MacOSX the CD is
found in the Volumes folder; on Linux it depends where the CD has been
mounted - it should usually be found at /mnt/cdrom; on Solaris is will be
found at cdrom/dcrom0). To go up a directory at any stage, double click
on ".."



On the CD there is a directory called "Models".   Navigate to this
directory.  It contains a sub-directory for each of the EMAP models
(these are denoted by Theiler stage) and within each Theiler stage
directory is a 3D file of that particular embryo model (embryo_1_3D) as
well as left and right 2D whole mount views of the same model
(embryo_1_WM_left and embryo_1_WM_right).

The Sox10 image is a right side view of a TS15 embryo.  Navigate to the
ts15 folder and open it.  You will notice that there are two different
wholemount models for TS15.  They represent different time points
within TS15.  Model 3 is a slightly earlier embryo than model 2.  The
Sox10 data embryo is a closer match to model 3, so open the right hand
image file of embryo 3 by double clicking on it.

The MAPaint window will change to show a square with 2 red sides and
2 green sides. This indicates that a 2D target image has been loaded
into MAPaint:

:

 From the "Options" menu, select "2D Warp Input".  A window entitled
"2D warp input dialog" opens with an image of the standard model
embryo:



Note that for all of the embryo stages where the tail curls behind or in front of the head
or body, the tail has been virtually cut from the model and moved to allow all parts of
the standard wholemount view to be annotated as either being examined or not
examined.

 Click on the "2D warp input controls" square and another window
entitled "warp2DInteractDialog" will open:

 Go back to the "2D warp input dialog" window and click on the
"ReadSource" button. A dialogue box entitled "Read Warp Input
Source Object" will open and then select Sox10.jpg from the list by
double clicking on it.  (For source images other than jpg’s, select the
appropriate file type from the drop down “image type” menu).  The
Sox10 image is loaded into the middle panel of the
"warp2DinteractDialog" window:



This window is the one used to manually warp the input data onto the embryo model.
The left hand panel contains an image of the embryo model.  The middle panel
contains the input data image and the right hand panel contains an overlay of both of
these images. To get the images into the fields of view, either magnify (click on "mag+"
button) or reduce (click on "mag-" button) each separately.  To adjust the contrast of
the images in each panel, click on the up and down arrows in the relevant panel. To
change the two colours in the overlay panel, click on this panel using the right- hand
mouse button, go to 'overlay method' and select a colour combination that you like (red-
cyan usually gives good contrast).

 Start entering tie-points between the embryo model (left hand panel)
and the input data image (middle panel). To add a tie point, move the
cursor to an appropriate place on the standard embryo model and
click with the left hand mouse button (a red dot appears), then move
the cursor to the equivalent point on the input image file and click
with the left hand mouse button (both dots will change to green).

Moving the cursor back over the dot will change the colour of the two
linked dots to red and can be used to determine which dots are
linked to each other in the two panels and can be used to adjust their
position independently of each other by clicking on and dragging one
of the points. To remove two linked points, move the cursor over
either and use the middle mouse button to remove both.

Initially enter 4-8 tie-points around the edge of the embryo at easily
recognisable positions e.g. at the crown and rump etc.  This ensures
both images are of similar size and helps in subsequent tie-point
mapping.

Enter more tie-points at easily recognisable landmarks (eg. otic
vesicle, optic cup, limb bud, heart etc) paying particular attention to
regions of gene expression.

Typically around 30-50 tie points may be required to adequately warp the expression
pattern onto the model:



This process works by warping an underlying triangular mesh across the two images.  For
every triangle in the left hand image there is an equivalent triangle in the central image.
You can see the underlying mesh by right clicking on the left hand and middle panels and
selecting the “show mesh” option:

If you try to enter a point that generates an invalid mesh (eg. when the mesh has to
'fold' back over itself - in these cases the problem part of the mesh will be seen in a
different colour to the rest of the mesh), an error message will appear in a window
entitled "confirm dialog" giving the options of 'select yes to attempt to correct the mesh
automatically or no if you want to move some of the tie points or reset the mesh
parameters and try again".  Initially it is a good idea to select "no", remove the
inappropriate tie-point using the middle mouse button and try again.  If you still have a
problem, zoom in to help when adding tie points.  Depending on the original data,
another way to help in getting the mesh to tolerate the warping required may be to
adjust the "Mesh min distance" and "Mesh max distance" parameters in the "2D Warp
Input" window.  These are the minimum and maximum distances that the sides of the
triangles will stretch or contract to during the warping.

 When you are satisfied with the warping, save a file that records the
position of the tie points (a 'bib' or bibliography file). This can then be
used to read in the warped data at a later date if required.  Do this by
clicking on the "I/O" button under the left hand panel while using the
right hand mouse button and select "write warp data" from the list
that appears. A window will appear entitled "Get Filename Dialog"



with the default file name of "MAPaintWarpParams.bib":

 Change the name of the file to Sox10.ts15.3.r.bib  as shown
below and click on the "OK" button.

The standardised way for writing bib files for wholemount data mapped by MAPaint for
later inclusion in the EMAGE database is filename.ts##.X.*.bib where ts and
the two following numbers ## refer to the Theiler stage of the model you are mapping
onto,  X refers to the number of the embryo model (e.g. for TS15 and TS16 there are
more than one embryo model) and * will either be  l or r to indicate whether the view of
the model was left or right.
bib files must be saved using this standardised nomenclature in MAPaint
otherwise it will not be possible to enter this data into the EMAGE database later
on.

Having aligned the two images, the next part of the process is to denote regions on the
wholemount view representing different areas of Sox10 expression (or non-expression) using
a thresholding method.  The program allows for regions of strong, moderate, weak and
possible expression to be denoted as well as regions that have no detectable expression and
areas that have not been examined.  Not all of these may be required.  Bear in mind not to
over-interpret the data (ie. adding strong, weak and moderate levels of gene expression may
not be any more meaningful than adding two regions).  In this Sox10 example, denoting
regions of strong and moderate expression is enough (along with regions that have no
expression detected and regions that have not been examined).

 Get ready to read in the colour image for thresholding by going back
to the "2D warp input dialog" window and clicking on "Import>>". A
new panel will appear on the right hand side of the window.



 Click on the "read" button above the new panel and a window entitled
"read signal object" will open. Select the Sox10.jpg source image
and click on "OK" (For source images other than jpg’s, select the
appropriate file type from the drop down “image type” menu).  The
image will then appear in the right hand panel of the 2D warp input
dialog window. To fit the image in the panel, either magnify (using
"mag+" button) or reduce the image (using the “mag-“ button) as
required.

.

 Look at the colour image of Sox10 to discern the region of highest
signal intensity and then go to the "2D warp input dialog" window.
Select the “Threshold” tab in the “Signal processing” panel, and then
select the “Interact” tab on the right.  Click once with the left hand
mouse button on the region of the data image with the strongest
signal.  Continue to hold the button down while dragging the cursor to
an appropriate region on the image that denotes the lower limit of
strong gene expression.  Then release the mouse button to define
the lower limit of strong gene expression.  Don't worry at this stage if
you also incorporate some yellow areas corresponding to other areas
such as debris as these will be removed later.  If the region selected
is not appropriate, click on "reset defaults" and try again.



Note: it may sometimes be easier to extract signal by using other strategies apart from
the "interact" method.  For example the "single" option sometimes works better to
extract either the overall image density (ie. in grey mode) or just the blue, red or green
colour channel (while in RGB mode) or the cyan, magenta or yellow colour channel
(while in CMY mode).  Try some different methods in this Sox10 example to see how
these signal extraction methods differ.

 Click on the "map the data" button under the right hand panel and the
data will be transferred onto the standard model in the left hand
panel in red.

 If you are satisfied with the positioning of the transferred data,
proceed to the next step. If it is not satisfactory, click on the "undo
mapped data" button and re-adjust the tie points in the
"warp2DinteractDialog" window and then re-save the bib file
Sox10.ts15.3.r.bib to record the re-adjusted position of the
points.



 Write another "bib" file that contains information on the thresholding
levels for the regions of strong gene expression by clicking on the
"I/O" button under the left hand panel using the right hand mouse
button selecting "write warp data" from the list that appears. As
before, a window will appear entitled "Get Filename Dialog" with the
default file name is MAPaintWarpParams.bib . Change to
Sox10.strong.bib and then click on the "OK" button.

 Remove any red areas of debris that have been carried across with
the thresholding by going to the MAPaint window.  The program is
set by default to 'paintball' mode with the cursor appearing as a black
dot.  Use the middle mouse button to remove any areas of debris.
This may not be required. If you make a mistake, click on "undo".

The size of the paintball can be adjusted by selecting "tool controls" from the "options"
menu and then changing the Paint size with the slider.  The painting mode can also be
changed to other formats (draw, fill, threshold, affine etc) by selecting these from the
"Paint tools (2D)" menu within the "options" menu.  The behaviour of all of these tools
is such that using the left hand mouse button generally is used to add colour whilst
using the middle mouse button is used to remove colour.

 Now add any red areas that you feel represent true expression and
have been missed by the thresholding technique by using the
paintball with the left hand mouse button.  It may be necessary to
adjust the "Paint size".  Once again, If you make a mistake, click on
'undo' using the left hand mouse button.

When happy with the areas representing strong expression, the process is now
repeated for areas of moderate (yellow), weak (blue), possible (green) expression as
well as areas with no detectable expression.  The process used is exactly the same for
each however the domain has to be selected separately for each. Remember that not
all of these levels may be required.

 Select the moderate domain by choosing the "Domain" menu and
then the "Select" menu and finally "Moderate Expression".  The
border surrounding the embryo model on the left will change from red
to yellow.  Repeat the thresholding procedure so that the yellow
areas in the right hand panel now adequately cover sites of moderate
gene expression.  This can be done either by starting the
thresholding procedure again, and extending to include moderate
areas of expression, but is most easily achieved simply by moving
the threshold distance slider up which automatically extends the
range of the selected expression intensity. Again, don't worry at this
stage if you also include some yellow areas corresponding to other
areas such as debris as these will be removed later.

Click on the "map the data" button under the right hand panel and the
data will be transferred onto the standard model in the left hand
panel in yellow.



 Write another "bib" file that contains information on the thresholding
levels for the regions of moderate gene expression by clicking on the
"I/O" button under the left hand panel using the right hand mouse
button selecting "write warp data" from the list that appears. As
before, a window will appear entitled "Get Filename Dialog" with the
default file name is MAPaintWarpParams.bib . Change to
Sox10.moderate.bib and then click on the "OK" button.

As before, remove any areas of debris carried across and add in any regions of
expression not picked up in the thresholding.  Continue on in the same way for all the
expression levels required (strong, moderate, weak and possible).  Bear in mind it is
not necessary to use all of the available levels of expression, only those required to
accurately describe the expression pattern in the image.  Remember to choose the
expression level from the domain menu each time, and also remember to save an
appropriately named bib file in each case (named in the standard manner ie.
filename.weak.bib and filename.possible.bib).

 Now denote the areas on the wholemount view with no detectable
expression by firstly selecting the "Domain" menu and then the
"Select" menu and "Not Detected".  Increase the thresholding until the
whole image on the right is selected in yellow, and click on “map the
data”.  All parts of the model representing the image should now be
defined as regions of expression or non-expression.  Adjust any
areas missed by the thresholding using the draw tool or the paintball.



 Finally, denote areas on the wholemount view that have not been
examined by firstly selecting the "Domain" menu and then the
"Select" menu and then "Not Examined".  In the "2D warp input
dialog" window use the fill tool in unpainted areas and the paintball to
represent areas of the model embryo that have not been examined in
your experiment. Note that the brown "Not Examined" domain is
dominant over all other domains and will paint over them.  If you
make a mistake, use the "undo" button.

This is used to denote which parts of the embryo model in the view you have mapped
onto have not been examined.  For example, if the tail curls around behind the head in
the original image but is exposed in the model (because its been virtually removed) it is
necessary to denote the tail as not being analysed (because it couldn’t be seen in the
photo). Likewise, if part of your data embryo was missing it would be necessary to
denote that part of the model as not being analysed.

In this case the tail is twisted so the dorsal most aspects of the tail are not visible in the
data image.  The tail also covers a small region of the distal tip of the forebrain and
should be denoted as being not examined (see image on next page).

 Save the files denoting the regions of different expression levels by
first dismissing the  "warp2DinteractDialog" pop up window by
clicking on the "Dismiss" button. The border surrounding the image of
the embryo model in the "2D warp input dialog" window changes to
black signifying the files are ready to be written.



 In the MAPaint Window select from the "Domain" menu, "Save All
Domains". This automatically saves the files in "woolz" format (.wlz)
to your working directory (i.e. the directory you were in when you
started MAPaint) for whichever domains you have created as:
strong.wlz; moderate.wlz;  weak.wlz; possible.wlz;
notDetected.wlz and notExamined.wlz

 Quit the MAPaint program. A window appears entitled "confirm
dialog" with the message "really quit? " Click on "yes". Another
"confirm dialog" window appears with the message "really really quit?
" Click on "yes" and the program quits.

 Check that you have the relevant files that will be required to load
this entry into the EMAGE interface later.

These are:

 the original image file Sox10.jpg,
 the bib file to tell the EMAGE interface which view of the

wholemount to use (left or right) and will in this case be
Sox10.ts15.3.r.bib.

 the appropriate .wlz files that denote the different regions of
expression you denoted: strong.wlz; moderate.wlz;
notDetected.wlz and notExamined.wlz


